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OptiFDTD 15.0.1

OptiFDTD 15.0.1 Release Notes

17 August 2020

Minor Enhancements and Bug Fixes

Use of Finite-Difference mode solver in semi-vector mode could result in simulation 
hanging
During a simulation, the process of saving a mode could result in the simulation hanging when using Finite-

Difference mode solver set to semi-vector mode.

Initialization of heat absorption properties form
During initialization of the heat absorption properties form the central frequency and normalized values were 

initialized incorrectly.

Design files could get locked in use
Corrected a bug where, in some cases, when a design was closed the file could be locked and standard 

windows file access (delete, cut, etc.) were not available.

Update to VBScript functionality within OptiMode
Recent Microsoft updates within the VBScript engine bundled within Windows resulted in an incompatibility 

between the Windows scripting engine and the analyzer files generated from simulations. This 

incompatibility results in analyzer files from simulations with scripting or parameters sweeps not opening. 

While Microsoft has released another update to address the issue, it is currently our recommendation that in 

addition to updating Windows users should install the latest version of the product to ensure proper 

operation.
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Updated codec availability and default setting for movie recording
Due to instabilities in the VP9 codec resulting in inconsistent simulation times, it has been removed from the 

list of available codecs within the movie recording settings for observation areas for this release. The VP8 

codec has been set as the new default codec within the settings.
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OptiFDTD 15.0

OptiFDTD 15.0 Release Notes

14 February 2019

Summary

OptiFDTD strives to provide optical engineers and researchers with the most accurate & easy-to-use tool for 

the design and analysis of photonic devices. In this release of  we have included a series of OptiFDTD

enhancements that focus on the user experience and design flow.

These new features include:

New upgraded video codecs

The multi-tasking of property edits

Enhanced scripting capabilities for CAD file import

Integration with Optiwave’s new Cloud Compute option

New features and enhancements

Video codecs
With improvements in video technology,  has high quality video codecs available for use when OptiFDTD 15

recording simulation results. Videos of the time evolution of fields for arbitrary structures provides resources 

for research and in-class teaching materials. Available codecs are VP8, VP9, ZLIB, and Theora.

Multi-tasking property edits
OptiFDTD 15 has extended the design workflow based on the internal project browser within OptiFDTD 

 by enabling multiple dialogs for components, materials, or profiles to be simultaneously open. Designer

Additionally, property dialogs of linked components, waveguides and profiles have the ability to open 

corresponding dialogs. These capabilities streamline the overall design workflow.
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Enhanced scripting capabilities for structure import
Increasingly complex designs combined with dynamic analysis requires not only the ability to import 

structures from known standard CAD file formats but  now provides the ability to automate the OptiFDTD 15

configuration and import of these files.

Optiwave's new cloud compute
OptiFDTD 15.0+ users will be able to export FDTD designs to Linux files (.fdu) and simulate them using our 

new Cloud Compute service. There is no need to sign up for an Amazon Web Services (AWS) account, 

example files will be provided, and full functionality & access will be provided to all interested users.

Minor Enhancements and Bug Fixes

Optimization of Project Browser Controls
The Project Browser, introduced in , has acquired further controls over the design layout OptiFDTD 14

including component deletion and order.

Real time estimate reporting during simulations
The simulation dialog now provides tracking estimates for simulation duration, elapsed time, and time 

remaining.

Improved user control over accuracy GDS II export
The ability to export structures as GDS II layouts has been upgraded to now provide better accuracy in 

polygon generation for curved structures.

Optimization of OptiMode Finite-Element Method (FEM) mode solver interface
The interface between the  FEM mode solver and  has been optimized to improve  OptiMode OptiFDTD

accuracy with mode injection.

Enhancements to Lorentz-Drude Dispersive material
The Lorentz-Drude material now provides users with a plot of the refractive index dispersion based on the 

model coefficients. The coefficients can be user-generated or automatically generated from experimental 

data files. Some minor issues with importing unknown characters or use in non-English operating systems 

were also corrected.
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Improved accuracy of the calculation of frequency domain results for observation 
points
There was an opportunity to improve the accuracy of the reported frequency spectrum calculated from the 

time domain information reported from observation points during continuous wave simulations.

Updated XML support for nonlinear materials
Issues within the XML definitions for nonlinear materials have been updated, facilitating saving of properties 

and export to XML.

UI glitches with Sellmeier tabs for dielectric material
The extraneous tabs that could appear while setting anisotropic settings for a Sellmeier defined constant 

dielectric material have been removed.

Removed deprecated tabs within input plane modal selection
The Wafer and Waveguide tabs within the modal input have been removed as they have been deprecated.

S-Parameters
The input field button within the S-Parameters dialog was incorrectly linked to the waveguide dialog, it has 

now been corrected to point to the input plane dialog. There was also an error in switching from amplitude to 

power causing error messages, this has been corrected. Accuracy of calculated S-Parameters has also 

been increased through improved field exports.

Consistency of selected field tabs in Analyzer
When switching observers Analyzer would reset the selected field component to Ex. The UI has been 

update such that the selected field component is retained when switching between observers.

Renaming of materials
Materials and profiles that are in use can now be renamed with the name change propagating through the 

design.

Correction to Is2DTEHzCollected
The VB script command Is2DTEHzCollected now returns the corresponding value for the Hz field 

component, correcting a previous error.
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Export of mesh for observation line along x axis
The z-directed observation line now returns the correct positions when exporting the mesh.

Installation notes

Intel Redistributable Libraries installation

As part of the installation process, Intel redistributable libraries are installed alongside with OptiFDTD and 

(optionally) OptiFDTD samples. Please note that a reboot of the computer is required after installation for 

OptiFDTD to function properly.
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OptiFDTD 14.0

OptiFDTD 14.0 Release Notes

18 January 2018

Summary

In this major release of OptiFDTD we have introduced a new material management interface built into the 

OptiFDTD Designer, including automated fitting of user provided refractive index data to a Lorentz-Drude 

model. This release also introduces the debut of 2 new features: The ability to calculate S-parameters for 

passive optical components and access to the OptiMode full vector finite-element (FEM) mode solver for 

modal input. We have focused on user experience in both creation of designs as well as extracting data 

through post-processing.

New features and enhancements

Integrated material and profile management
OptiFDTD 14 has integrated the management of both materials and waveguide profiles within the Project 

Browser of OptiFDTD Designer. The Profile Designer application has now been deprecated and will be 

removed in the future. Materials and profiles can be created through simple context menus or even imported 

from previous designs through drag and drop functionality by storing material models in XML files. Common 

material definitions come pre-installed as XML files in the material library and can easily be added to by 

exporting materials defined within OptiFDTD.

Further improving the user experience, OptiFDTD 14.0 introduces the ability to upload refractive index files 

and have that data fit to a Lorentz-Drude model to create materials for use within simulations. The data files 

can be from references, user generated calculations, or experiments allowing customers access to a broad 

range of materials.

Note: As a deprecated application, Profile Designer  new features and does not include

improvements, such as the new Lorentz-Drude material fit functionality.
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All new S-parameter ports
The new S-parameter port introduces a powerful integrated source / detector configuration that can be used 

with OptiFDTD's scripting capability to complete the required simulations. The S-parameters can be 

generated within OptiFDTD Analyzer and plotted for user analysis or even exported for use in OptiSystem or 

OptiSpice in integrated or discrete optical circuit simulations.

Upgraded field movie creator
The generation of movies of the time varying fields within OptiFDTD simulations has been upgraded, 

providing users with improved customization. Additionally a number of bug fixes have been introduced, 

increasing stability of the tool.

Full vector far field calculator
Complimenting OptiFDTD's current suite of post processing tools is a new full vector far field calculation that 

is capable of providing accurate results for fields over a wide angle range within the far field regime by 

loading vector fields from OptiFDTD simulations through a streamlined user experience.

Integrated access to OptiMode finite-element mode solver
This release comes with the integration of the latest OptiMode, providing access to the new finite-element 

method (FEM) mode solver. This mode solving utility is a fast and extremely accurate method that provides 

solutions for the full 6 components of the electromagnetic field and is capable of working with a wide array of 

waveguides.

Additional scripting capabilities
New VB script functions have been included within the OptiFDTD environment, providing users the ability to 

script changes to the settings for the discrete Fourier transforms (DFT) performed during scripted 

simulations

Minor Enhancements and Bug Fixes

Upgraded viewer settings
A viewer upgrades have been introduced, including improved overlays of waveguide outlines and Brillouin 

zones in the Analyzer and PWE Bandsolver. Within the X-Cut and Z-Cut views of either refractive index 

profiles or field data there is an easy to use utility that provides users with automated calculations of widths 

at full width at half max (FWHM), 1/e, 1/e^2 and user defined ratios. These calculations include linear 

interpolation between data points to provide improved accuracy in the width measurements.
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Point source algorithms updated
The algorithms for implementing the point source in OptiFDTD have been updated to provide results with 

improved accuracy relative to user specifications.

Reconfigured finalization steps for CW simulations
Finalization steps within continuous wave (CW) simulations in OptiFDTD are used to ensure that enough 

time (number of steps) have elapse to allow the system to have reached steady state. The calculation for the 

number of steps required has been reconfigured as previous settings resulted in unnecessarily long 

finalization steps.

Improved interfacing with OptiMode
Configuration files and settings are now passed between OptiFDTD and OptiMode through XML files, 

improving the communications between the products when calculating modal inputs.

Waveguide selection for modal input
The selection of waveguides for modal input through input planes has been reconfigured to provide users 

with the ability to send the cross section along the input plane to the built in mode solvers in addition to the 

option to select of waveguides. Tilted waveguides will not be permitted as selections for modal input.

Streamlined user access to variables and functions
Management of the Ok and Cancel functionality as well as dialog warnings have been streamlined and 

corrected to improve user experience.

Corrected error handling of data
Error handling within the data viewers have been updated to handle data from failed simulations or corrupted 

data to prevent unexpected shutdowns of the software.

Selection issue in 3D viewer solved
When rotating 3D objects objects would become un-selected, this has been corrected and objects will 

remain selected.

Finite-difference mode solver set as the default option for input plane modal input
When setting the input plane for modal input there are three mode solvers available to the user: ADI, FD, 

and FEM. As a broadly applicable method with the least amount of computational overhead the FD mode 

solver has been set as the default method when launching the dialog for configuring the modal input.
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OpenGL issue within virtual machine environment
Backtracked the versioning on updated graphics rendering engine to manage incompatibilities with the 

virtual machine (VM) environment which affected the display of refractive index views when used on VMs.

Corrected file prefix usage
Minor bug fixes addressing proper use of prefixes when exporting data and in the filter within the File Open 

dialog.

OWA Converter tool ported to 64-bit
The OWA converter within the OptiTools suite available to OptiFDTD has been update to the 64-bit software 

environment.

Design tutor moved to help menu
The Design tutor for helping new users with the OptiFDTD product has been moved to the help menu to 

better position it for users looking for assistance.

Re-labeling of options within the nonlinear material creation menu
When the labels for the types of nonlinear material available have been renamed to 2nd order, 3rd order 

(Kerr), 3rd order (Kerr - Response time), and Raman. This clarifies some of the ambiguity that existed in the 

previous naming scheme regarding the 3rd order nonlinearity models. There are 2 Kerr models in OptiFDTD: 

(Kerr) is a standard implementation of the Kerr nonlinearity; (Kerr - Response time) is an implementation of 

the Kerr nonlinearity which includes the response time of the material.

Installation notes

Intel Redistributable Libraries installation

As part of the installation process, Intel redistributable libraries are installed alongside with OptiFDTD and 

(optionally) OptiFDTD samples. Please note that a reboot of the computer is required after installation for 

OptiFDTD to function properly.
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OptiFDTD 13.0

OptiFDTD 13.0 Release Notes

1 Jul 2016

Summary

In this major release of OptiFDTD we have introduced new graphical user interface improvements for the 

Designer, Simulator and Analyzer. The new interface simplifies the design process, simulation and analysis 

of complex devices. This release also includes the latest version of the Optiwave mode solver application, 

OptiMode version 4.0, which delivers the 64-bit Anisotropic Mode Solver and new Mode Measure 

calculations. For more details on OptiMode ver. 4.0 see "OptiMode Release Notes" document.

New features and enhancements

New Detector Analysis
The Detector Analysis tools have been redesigned to simplify and make access to the important information 

more convenient. The Detector Analysis functionality has been brought to the front of the Analyzer 

application. You can easily browse the Detectors within the project browser tree, view the graph or optical 

field for the selected detector in the application main window and have an overview of the related key data in 

the information pane, in which the user may observe parameter values (if any) associated with the project, e.

g. parameter sweep. We have added a number of toolbars which provide fast access to the menu options, to 

control the displayed information.

Note: To help with the transition from the old UI to the new one, we still keep available the old "Detector 

Analysis" interface under Tool menu.
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Import of 3D shapes into the Designer
With introduction of this feature, the users are no longer confined to the built-in 3D Editor and limited choice 

of 3D shape primitives. The users can use third party 3D CAD software of their choice, export the designed 

shapes into the generic (IGES) 3D file format, import it into the Designer and then configure for simulations. 

One can develop a number of independent, stand-alone objects, even a full layout, and import it into the 

Designer for simulations.

Dynamic optical field visualization during simulations
Typically, the FDTD simulations are like a "black box", once started the user has to wait until the simulation 

complete to observe the simulation progress (eg. movie) or the simulation results. With this release we have 

enabled the user to actually observe the optical field formation during the simulations. One can choose to 

visualize optical field forming within the Observation Areas and/or dynamically selected cuts across the 

simulation domain.

Shape cross-section outline over the optical field view.
In the Observation Area optical field view of OptiFDTD Analyzer, the user may choose to display outline 

overlay of the 3-dimensional shapes intersecting the Observation Area. This great visualization tool allows to 

observe the relation between the Layout shapes and formation of the optical field.

Simplified Waveguide Profile and Material management
We have removed the strong dependency on the old master.plb file, the former database of Waveguide 

Profiles and Materials. We have provided import/export functionality supported by XML defined file format. 

The user may import into a project (or export from it) a Profile and/or Material definition into an independent 

(XML) file. This allows materials and waveguide cross-sections to be easily defined, shared. Now, one can 

run OptiMode, OptiBPM, and OptiFDTD designers at the same time, as these applications are no longer 

locked out of the master.plb use.

Note: Access to master.plb is still available, so that users may export their Profiles and Materials. The 

support for master.plb will be phased out, eventually.

OptiMode XS Designer and Profile Designer Tutor pages
To make it easier for the users to find required information as to the OptiMode XS Designer and Profile 

Designer usage, we have added the "Design Tutor" menu. The Design Tutor shortly describes basic 

constructs and operational concepts for these applications.



Release Notes

15

Important Usage Notes

Input Field mode calculations in the Designer
The following applies when performing Input Field mode calculations for simulations:

The whole wafer cross-section at the Input Plane location is sent to the selected Mode Solver (Finite 

Difference or ADI). It includes cross-sections of all objects (waveguides and/or 3D objects) 

intersecting with the Input Plane.

The mode solvers interpret each of the cross-sections as representing a straight waveguide, 

perpendicular to the Input Plane.

Note

There is no tilt angle applied on the solved modal field in simulators during the field injection, even if 

there is only a single waveguide intersecting with the Input Plane

Legacy projects using VB Script to define Gaussian beam size (Half Width)
With the changes to the Gaussian beam size and Gaussian pulse parameter definitions (see the "Minor 

" section below), the VB Script projects which define the Gaussian beam Enhancements and Bug Fixes
Half Width in the script code have to be modified to use the new interface functions. Running the simulations 

with the old VB Script code will abort on VB Script unsupported function call error.

The required VB Script changes

The old (phased out) interface function  value)SetHalfWidth(String

Has to be replaced with the function SetWidth(String value)

Important

In order to get the same result, set the pulse width to be times larger than the former 2 * Sqr(2) 

Half Width value.For example, if the half-width had been previously defined as 0.55 um, set the 

new value as follows:

InputPlane1.SetWidth "0.55 * 2 * sqr(2)"

See the " " manual, chapter "VBScript Commands", under the "Input Visual Basic Scripting Reference
Plane Manager", page "Input Plane Object".
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Minor Enhancements and Bug Fixes

Changes to the Gaussian pulse parameter and Gaussian beam size definitions
1. We have renamed the "Gaussian Modulated Continuous Wave" (GMCW) as "Sine-Modulated Gaussian 

Pulse" to bring it up to date with the commonly used terms in the FDTD simulation domain.

We have modified the "Sine-Modulated Gaussian Pulse" time domain parameter definitions as follow:

The old "Time Offset" has been replaced with "Time Delay"

The old "Half Width" definition (which was T - "standard deviation" of the Gaussian function) has been 

replaced with "FWHM" (Full Width at Half Maximum).

2. We changed the way the Gaussian Beam size is defined. The old Gaussian Transverse "Half Width" 

definition has been replaced with

The relation between the old "Half Width" and the current Beam Size definitions is:

See the , the "Light Sources" chapter for details.Technical Background

Re-introduce ADI mode solver to input field properties
On the popular demand we have re-introduced ADI Mode Solver to Input Field's Mode Solver choice 

options.

Corrected sporadic crashes when observing Refractive Index distribution in 
Designer
Fixed. On some project, switching between the 3D Refractive Index tab and 2D Refractive Index tab while 

changing observed (XY/XZ) direction used to crash the application.

Corrected the option to “run until user stops execution, ..." when a point detector is 
present
Fixed. Whenever a point detector is present in the layout, when using the "run until user stops..." in the 

simulator options, the simulator stops right at the start..

Reconfigured the update of the default values of time offset and half width after 
editing the wavelength
Fixed. The Point Source property settings. The default "Time Offset" and "Half Width" values on "Gaussian 

Modulated Continuous Wave" setting page were not being updated when the user changed wavelength on 

"General" settings page.
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Special characters in object names may result in unexpected behavior
Fixed. When special characters (such as '=') are used in observation lines or other scriptable object names, 

the script interpreter will misinterpret the characters, resulting in unexpected behavior. Please refrain from 

using special characters in object names. For example, use '_' instead of '='.

Installation notes

Intel Redistributables installation
As part of the installation process, Intel redistributables are installed alongside with OptiFDTD and 

(optionally) OptiFDTD samples. Please note that a reboot of the computer is required after installation for 

OptiFDTD to function properly.



Release Notes

18

OptiFDTD 13.0.1

OptiFDTD 13.0.1 Release Notes

15 Aug 2016

Minor Enhancements and Bug Fixes

Relocated "Import 3D Shape..." menu option
The "Import 3D Shape..." menu option has been moved from "Draw" menu under "Draw->3D Shapes" sub-

menu. This menu option can also be accessed from the Design Tutor menu set, under the "3D Shapes". 

Corrected the saving of simulation 3D settings for time step size when non-uniform 
mesh is used
Fixed. Changes to time step size are not remembered in the "Simulation 3D Settings" window. Uncheck the 

"Auto" for time step size, and set a desired value. The value is properly propagated to the simulator, 

however, the value will be reset to the default value when the settings window is opened next time. 

Input Field Properties updated to correct issues with selection of Power/Amplitude 
on 3D Gaussian transverse tab
Fixed. Open the "3D Gaussian Transverse" tab in the "Input Field Properties" window. In the "Input 

Amplitude or Power" section select Amplitude, then Power radio button. Both options become active 

(checked) and there is no way of checking only one of them, until the window gets closed and opened again. 

Fixed OptiMode Designer crash when a project contains diffused waveguide profile 
or material
Fixed. OptiMode Designer may crash when opening a file project containing Diffused Waveguide Profile or 

Diffused Material.
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Corrected field component labels for simulation results in Analyzer
Fixed. On the Analyzer has wrong names: for both TE and TM tabs displaying field components, Hx, Ey, Hx 

simulations, instead of Ex, Hy, Ez for TM and Hx, Ey, Hz for TE.
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OptiFDTD 13.0.2

OptiFDTD 13.0.2 Release Notes

05 Jan 2017

Minor Enhancements and Bug Fixes

Display overlay objects contours to field graphs for 2D layout simulation result
Enhancement. The Object Overlay Contour display have been implemented for 3D simulation results. With 

this release update we have this feature for 2D Simulation results.. Now the "pure" 2D projects, where 

waveguide profiles have no 3D representation, can be visualized the same way as 3D simulation results.

Corrected power spectrum graph for 2D pulse simulations
Fixed. The power spectrum values and the resulting graph for 2D pulse simulations are wrong in the 

following cases:

Vertical Observation Lines - the Sx component(s) of Poynting Vector are checked.

Horizontal Observation Lines - the Sx component(s) of Pointing Vector are un-checked.

Updated discretization issue when non-uniform mesh is lower resolution than 
standard mesh
Fixed. The material distribution for discretized shapes located in non-uniform mesh areas with lower mesh 

density than the regular mesh is incorrect.

Note: Only the projects with non-uniform mesh of lower density than the regular mesh were affected by this 

issue.



Release Notes

21

Correct Analyzer crash when displaying Observation Area for projects without Input 
Plane
Fixed. Analyzer crashes when displaying simulation result for project designs which have no Input Plane, 

just Point Source, and Observation Area(s).

Addressed inconsistency between Height Plot and Image Map
Fixed. The waveguide overlay contours displayed on the Image Map is correct, however, when the display is 

switched to Height Plot the contour overlays are wrong.

Added PBG Cell Edit context menu
Fixed. The context menu (pop-up menu) for "turning on/off" PBG cell doesn't open.

Corrected disabling of toolbar buttons Re, Im, Amp for H field component for 3D 
simulation results
Fixed. The Analyzer toolbar buttons used to change the displayed aspect of the (complex) optical field, the 

Re, Im, Amp, Pha, etc. are disabled for 3D simulation results, when H field component is displayed.

Installation notes

Intel Redistributables installation
As part of the installation process, Intel redistributables are installed alongside with OptiFDTD and 

(optionally) OptiFDTD samples. Please note that a reboot of the computer is required after installation for 

OptiFDTD to function properly.
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OptiFDTD 13.0.3

OptiFDTD 13.0.3 Release Notes

16 Mar 2017

Minor Enhancements and Bug Fixes

Add copy/paste functions to the material coefficient definition control.
Improvement. Implemented copy/paste functionality to fill the grid of material definition coefficients (eg. 

Drude-Lorentz) in the Profile Designer.

Corrected error which caused launching field exported from observation area 
propagates to be in wrong direction.
Fixed. Launching as custom field a field obtained from Observation Area in prior simulations, results in field 

propagation in a different direction than the propagation direction expected from the field reaching the 

Observation Area.

A channel profile with slanted wall and offset layers now properly rendered in 
viewers.
Fixed. In some cases of waveguides using Channel Profile with slanted walls and offset layers, the 

waveguide is not properly rendered in the 3D Editor - parts of the waveguide walls are missing.

Set the initial position of the temporary observer plane to the middle of the cut axis.
Improvement. When defining a temporary observer for the runtime field view in Simulator, the initial observer 

plane position used to be set to the start position of the cut axis. It has been modified to set to the position at 

the middle of the cut axis. For example, a YZ observer plane will be set at X=0, an XZ observer plane will be 

set at Y=0.
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Corrected script behaviour for when /SCRIPT option is selected.
Fixed. For the 3D simulator, the "Simulate Using Script" has to be selected in order to run a script that is 

loaded from a file specified by using the '/SCRIPT' in the command line. If the '/SCRIPT' option is provided in 

the command line, the simulator should run the script even the "Simulator Using Script" was not selected (in 

the Designer).

The modified flag is now set when achange is done only to the nonuniform mesh 
parameters.
Fixed. Editing the non-uniform mesh parameters does not change the project status to "modified" and does 

not prompt the user to save data before the simulations. When the user changes the non-uniform mesh 

parameters and proceeds to run simulations, he would run simulations on the old data set.

Corrected displays of columns with dispersive materials form for double-click 
behaviour.
Fixed. Add a new dispersive material in the Profile Designer. By default the data grid for  "Lorentz isotropic

Dispersive" material with 3 columns for "Sellmeier Equation" coefficients. Proceed to change the column size 

by double-clicking on the vertical column separator between columns. This action causes display of two 

more columns: "Ay(F/m)" and "Az(F/m)" which do not belong to  settingsisotropic

Updates to DFT phase calculation for line and area detectors
The calculation of the imaginary part (affecting phase) of the discrete Fourier transform (DFT) calculation in 

OptiFDTD has been updated. The amplitude and power calculations/analysis remain unaffected.

Removed redundant prompt to select a row for deleting a variable even if the row is 
already selected and highlighted.
Fixed. In the dialog "Variables and Functions", select a variable by clicking the row number. This row gets 

highlighted. Click any space below the last row. The selected row still remains highlighted. Click "Delete" 

button. A message "Please click a row number which you want to delete" will pop-up, even if the row is still 

highlighted (presumably selected).
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OptiFDTD 12.0

OptiFDTD 12.0

16 January 2014

Summary

In this major release of OptiFDTD we have introduced a new graphical user interface for OptiFDTD Designer 

and OptiFDTD Analyzer. The new interface simplifies the design, simulation and analysis of complex 

devices.

New features and enhancements

Full 64-bit software
OptiFDTD has been thoroughly re-engineered to take into account the evolution of processors and memory. 

It is now presented as a  for increased performances and virtually no memory limits. 100% 64-bit software

Users of 32-bits operating systems have not been forgotten and are offered our 32-bit OptiFDTD software 

package .OptiFDTD 32-bit, for free

3D editor
A new  has been introduced in OptiFDTD Designer and OptiFDTD Analyzer. Components can now 3D Editor

be positioned, selected and edited directly in 3D. Simple mouse operations enable zooming, panning and 

tumbling around the simulation domain. For more precise positioning and better visualization of hidden 

geometry, the 3D editor can be replaced by a 4-quadrants window showing 3 orthographic views (XY,XZ, 

YZ) and a 3D representation of the layout. The Wireframe mode can be activated to show intersecting 

objects more precisely.
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Project Browser
Along with the 3D editor, the project browser window can dramatically enhance productivity when designing 

a FDTD simulation. All components (geometry, input sources, and detectors) of the project are categorized 

in a single window and can be rapidly accessed for edition.

Design Tutor
For first-time users, designing a FDTD simulation can sometimes become overwhelming. The Design Tutor 

is a menu in OptiFDTD Designer that presents a step-by-step workflow for preparing, designing and 

simulating photonic components. Each step is shortly explained in the form of an online help. This menu can 

also be used by more seasoned users as a shortcut for common functions of the software.

Advanced Refractive Index Viewer
The refractive index viewer, as well as many graphical windows, have been improved. The view can be 

adjusted in 3D and the impact of a change in FDTD mesh size can be visualized directly.

Improved OptiFDTD Analyzer
OptiFDTD Analyzer graphical user interface has been modified to provide a better user experience. It now 

features the Project Browser and 3D Editor as well as an improved detector analysis window. Observation 

areas graphs are now clearer and mouse operations are now possible such as zooming, panning resizing of 

the window.

Smaller movie files
We have added a new, more efficient, movie compression algorithm for the observation areas detectors.

When large areas are recorded in time domain, the generated movie file was rapidly becoming too large for 

most movie players to handle. Now, movie files are significantly smaller while keeping the same quality and 

resolution.

Increased accuracy in OptiMode
OptiMode has seen significant improvements. Transparent Boundary Conditions (TBC) can now be used in 

the Finite Difference (FD) mode solver. The accuracy of the mode solver solutions is dramatically increased 

for leaky waveguides and high index contrast structures. OptiMode solver graphical user interface has been 

re-engineered to include better visualization graphs and mouse operations.
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Matrix and Mesh Converter Tools
Two new tools appeared in OptiFDTD Toolbox: and . The matrix Matrix Converter Mesh Converter  

converter creates output data files compatible with software such as Matlab™ or Origin™ from Optiwave’s 

fields data file format. The mesh converter on the other hand can convert an output field data file generated 

by OptiBPM and generate an input field for OptiFDTD.

Minor Enhancements and Bug Fixes

GDSII CAD import limited to version 5
The GDSII file format importer used to abort its operations when a newer file format was detected. Currently, 

the importer will proceed with importing the selected GDSII file, however, unsupported constructs will be 

omitted.

Installation notes

Intel Redistributables installation
As part of the installation process, Intel redistributables are installed alongside with OptiFDTD and 

(optionally) OptiFDTD samples. Please note that a reboot of the computer is required after installation for 

OptiFDTD to function properly.

Location of the Materials database file
In this version of OptiFDTD, the master Material Database file,  is installed in a location shared by master.plb,

all users. In Windows 7/8, this location is by default:

C:\Users\Public\Documents\OptiFDTD materials\Master.plb

If you require restricted access to the database, you can specify another location for master.plb from Profile 

Designer's "Options..." menu. You might have to manually copy the existing master.plb, if you want to 

transfer the existing materials to the new location.

the materials defined in an OptiFDTD project are stored within the project file and are not shared. 

If you would like to have them always available for use in other projects, you can copy them to the 

"Master" tree-node in Profile Designer. The materials available in the "Master" tree-node are 

stored in the master.plb database.
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All updates for this release

Improvements

Support for Observation Points export in scripts
Observation point time series data can now be exported using scripts (see  method in GetTimeSeries

 p. 70).OptiFDTD VB Scripting reference

Support for observation areas export in Linux simulator
Observation area data can now be exported using the Linux simulator. It uses the script functions described 

in OP-46 below and automatically exports f3d files.

Change color coding of axes in 3D editor
The axes in the 3D editor are now color coded according to their orientation.

Add intensity plots to Opti 2D viewer
Intensities (as defined by the square of magnitude) can now be displayed in Opti 2D viewer.

Plot intensity in observation area / line / point detector window
Intensities (as defined by the square of magnitude) can now be displayed in observation point / line / area 

detectors in OptiFDTD Analyzer.

Provide the user with the possibility to export files for OptiBPM
OptiBPM-compatible files (f3d files with Ex and Ey or Hx and Hy components) can now be created by 

OptiFDTD. This option can be set in OptiFDTD Designer by selecting Edit->Options->Generate OptiBPM 

 and exporting fields of type " " in OptiFDTD Analyzer DFT data export compatible field data files ExEy

window.

XML anisotropic materials import
Materials definitions can now be imported in the profiles and materials designer, using XML file format. The 

documentation under  (where  [Samples folder]\materials\graded_lens_XML_import\  [Samples folder]

represent the folder where the FDTD samples are installed, in  by default) provides an example Documents

of this functionality.
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VB script function for exporting total field intensities
Total field intensities, in the form |Ex|^2 +|Ey|^2 + |Ez|^2 , can now be exported after simulation using 

scripting functions (see and methods in  p. GetEIntensity  GetHIntensity OptiFDTD VB Scripting reference

73).

Support for movies and observation areas export in scripts now available
Movies and field data from observation area can now be exported using VB script functions (see 

,  and methods SelectComponentForMovie UnselectComponentForMovie ExportGUISelectedFieldData 

in  p. 72-73).OptiFDTD VB Scripting reference

The export function for fields take a wavelength as an argument. This wavelength must be present 

in the list of wavelengths generated by the DFT transform. This means that one cannot use an 

arbitrary wavelength here. To ensure a correct wavelength is given, first do a test-run of the 

simulation without the scripting checked, pick a wavelength of interest in the list displayed on the 

observation area window in OptiFDTD Analyzer, and finally use that wavelength in the script. A 

clever system will be devised in a latter release of OptiFDTD.

Xeon Phi cards support in the Linux simulator
Intel Xeon Phi copressor cards are now supported by the Linux simulator as an experimental feature.Please 

contact us for more details.

Bug fixes

Saving of dielectric Sellmeier parameters corrected
The Sellmeier parameters for dielectric materials where not saved when the "store" function was used. This 

issue is now corrected.

Changed displayed folder during "Save as..." to current folder
When opening a project file using Windows explorer and when using the function "Save as..." in OptiFDTD 

Designer, the folder displayed in the "save as" dialog box is now the current folder.

Unlimited number of field movies now available
An unlimited (dependent on the amount of memory available) number of movie files can now be recorded.

Profiles and materials designer updated to improve stability and performance
The profiles and materials designer stability and performances have improved.
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1.  

2.  

3.  

OptiTool Mesh converter updated
In OptiTools, the mesh converter had various issues such as calculation problems for non-square matrices. 

This update fixes this bug and improves the overall usability of the tool.

Corrected display of nonuniform mesh in analyzer for displaying the fields
When simulating using the non-uniform mesh options in the simulation dialog box, the analyzer observation 

area window wouldn't be updated to reflect the non-uniform grid. This update fixes this issue. The 

observation area displays a pixel's size according to the density of the grid. The export function now exports 

the correct number of data points.

It is possible to save the mesh points as a text file:

In OptiFDTD Analyzer, go to Simulation-> Simulation parameters...

Click Parameters... in the Nonuniform mesh section

For each dimension of interest, click Export mesh... to save the data as a text file

The f3d data file doesn't contain any reference to non-uniform mesh points. If the file is opened in 

OptiWave 3D viewer, a uniform mesh will be applied an structures will appear distorted. Data file 

formats will be modified to account for non-uniform data in a latter release of OptiFDTD

Corrected display issues when changing the display ratio in 2D layout in relation to 
3D editor
The 2D layout options now provide the expected behavior in the 3D editor window.
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Improvements
Add Sx+Sz tab in observation line analysis window

A new tab (Sx+Sz) has been added to the observation line analysis window. The values displayed represent 

the total Poynting vector crossing the observation line and is calculated as Sx+Sz = sqrt( Sx^2 + Sz^2 ).

Add Sx+Sz tab in 2D XZ observation area analysis window

A new tab (Sx+Sz) has been added to the observation area analysis window for 2D simulations. The values 

displayed represent the total Poynting vector crossing the observation area and is calculated as Sx+Sz = sqrt

( Sx^2 + Sz^2 ).

Bug fixes
Corrected initialization of 2D mode solver with multiple waveguides present

When multiple waveguides are present at the input plane, the 2D mode solver would display all waveguides' 

refractive indices even if one only was selected.

Point Source GMCW settings are now saved

The values entered in the point source GMCW settings were not being saved.

Non-uniform mesh improved handling along domain edge

In some cases, the non-uniform mesh would display the wrong refractive index at the edge of the simulation 

domain.

Corrected the default DFT calculation and waveguide selection

When simulating a GMCW pulse and keeping the default DFT parameters, the resulting calculated DFT 

wavelength were all equal to the central wavelength.

Updated VB scripting function SimCtrlParams3D.SetBoundaryX (or Y or Z) to include Periodic 

Boundary Condition (PBC)

In scripting, the function SimCtrlParams3D.SetBoundaryX (or Y or Z) was missing a the PBC case.

Linked source wavelength to default time step size calculation

The default time step size in the simulation parameters were not related to the actual wavelength being 

used.

Properly linked OptiViewers to the input plane

In the previous release, the internal field viewers OptiViewers were not linked properly to the input plane 

"user" field "view" button.
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Corrected bug in Profiles and Materials Designer and handling of materials with user defined 

parameters

In some cases where materials were being used in conjunction with user parameters and/or scripting, saving 

or modifying materials and profiles in the "Profiles and Materials Designer" would move and resize objects in 

OptiFDTD Designer.

Improved performance of refractive index view

In some situations, observing the refractive index (2D or 3D) in OptiFDTD Designer would slow down the 

graphical interface. This fix improves performances of the refractive index view.

Fixed incorrect error dialog regarding non-uniform mesh

The non-uniform mesh parameters window would show an error dialog about the layout dimensions even 

without modifying the mesh in some cases. This release fixes this issue.

Corrected calculation of Lorentz-Drude material coefficients when switching between wavelength 

and frequency

In the "Profiles and Materials Designer" Lorentz-Drude material parameters, switching from frequency to 

wavelength would sometimes result in the damping values resetting to default.

Removed erroneous error message triggered when viewing refractive index of a design that included 

a point source

When a point source is used and the refractive index was observed using the 2D or 3D refractive index 

viewer of OptiFDTD Designer, changing the observed component (real, imaginary or X, Y, Z components) 

would trigger an error message.

Properly linked the input plane source wavelength to the default DFT spectrum

The DFT options would always use 1.55 um wavelength as a reference even if a different wavelength was 

entered in the input plane CW window.

Corrected displayed information for non-uniform mesh in observation area snapshots

When simulating using a non-uniform mesh and creating a snapshot of an observation area, the snapshot 

boundaries would not correspond to the dimensions set in the observation area or the simulation domain.

Fixed window positioning for observation areas in OptiFDTD Analyzer

In some cases, when selecting observation areas in OptiFDTD Analyzer, the graph displayed in the 

observation area analysis window would move.
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Improvements
Add initial phase in the point source dialog

The  field has been added to the Point Source properties dialog. Values in degrees can be Initial phase

entered to describe the initial phase of the input field. Multiple input sources can have different phase values 

and model interference effects for example. A new scripting function named has been added SetInitialPhase 

to the Point Source object properties. See the Visual Basic Reference manual for more details.

Export mesh coordinates

The F3D file format used by Optiwave products does not include information about non-uniform meshes 

used in the simulation. This feature enables the export of the mesh information in OptiFDTD Analyzer. To 

export the mesh, from OptiFDTD Analyzer, go to  then select the observation area Tools > Detector Analysis,

or line you want to export. Click on the  button. If you expand the observation area or line Export Data...

(using the plus sign), you will be able to export the DFT values of the fields and / or the meshes associated 

by checking the box next to and DFT Mesh. The mesh points coordinates are exported in a single column in 

a separated file for each dimension.

Bug fixes
Matrix converter outputs transposed matrices

The Matrix Converter tool (in OptiTools toolbox) was outputting matrices in the wrong direction. Using the 

matrices in Matlab or Excel for example would involve transposing the values. This bug is now fixed and the 

results are now in the proper orientation.

Observation line graph now properly updated when DFT wavelength is changed

In OptiFDTD 12.2 we simplified the observation line detector analysis window by removing the  Update graph

button. A bug was introduced and updates for the observation lines were not done when the user changed 

the wavelength in the DFT values list. This bug fix corrects the problem.

Corrected mesh converter labels

The Mesh Converter (In OptiTools toolbox) conversion fields values were not labelled properly. This issue is 

now fixed.

Corrected instability in OptiFDTD Designer related to scripting

In some cases, clicking the  button or clicking would crash OptiFDTD  test script Simulation > Test script 

Designer. Stability of the OptiFDTD Designer application has been greatly improved and this type of issue 

should disappear with this new release.

Refractive index viewer has been updated to remove flickering while scripting
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While running the script (using the  function), the refractive index display would show update Test Script

problems (such as flickering). This issue is now fixed.

Corrected a default setting in clipping length for lens designs which caused an error

Some objects (such as E  and ) contain a property named . Due to lliptic lens Circular lens Clipping Length

some issues in the values validation, entering "0" in the field would result in an error. This bug is now fixed.



Release Notes

34

OptiFDTD 12.2.2

OptiFDTD 12.2.2

Bug fixes
Corrected Observation Areas for nonuniform mesh layout if they don't extend to lowest coordinate 

boundaries

The issue affects Analyzer calculating power for non-uniform mesh simulations. The power calculations were 

incorrect for the Observation Areas whose boundaries do not extend to the minimum coordinate values of 

the plane where the Observation Area was placed. For example, an Observation Area placed at some Z 

distance in XY plane (XY-cut), with rectangle boundary not extending to the (Xmin, Ymin) edges, would 

result in incorrect power value calculations.

Fixed 3D data viewer crashes when data grid is too large

The issue affects Viewer 3D when using "data viewer". In the Viewer 3D, open a data file which has over 

500 columns, select one of the field components and then open "data viewer". The application freezes due 

to the "data viewer" grid crash. The crash is related to limitation of the .NET v. 3.5 grid component. The 

issue has been fixed with grid component from .NET v. 4.5.
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